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1CHAPTER
WebPurchasing Setup

In this chapter

 “Requisition Considerations” on page 2

 “WebPurchasing Setup Checklist” on page 2

 “Security Group Setup” on page 3

 “User Security Setup” on page 5

 “Define Approval Rules” on page 11

 “Define Product Categories” on page 14

 “Define Products” on page 15

 “Configure Business Rules” on page 26

 “Define Tables” on page 27

 “Define Attributes” on page 28

With WebPurchasing, you can create and approve requisitions online. After you create the requisitions, 
you can view and update requisition records from the Records page of Accounts Payable, and generate 
purchase orders. To use WebPurchasing, you must have the optional module Purchase Orders, WebPortal 
liscenses, and a Web server. We recommend you use a dedicated server for WebPurchasing. This chapter 
details the tasks you should follow to setup WebPurchasing.
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Note: A purchase order is an order placed with a vendor for goods or services. Purchase Orders is an 
optional module in Accounts Payable you can use to process purchase orders and receipts between your 
organization and its vendors.

Requisition Considerations
Before using WebPurchasing, we recommend that your organization establish purchasing policies and 
procedures. When doing so, we recommend you consider the following questions:

• How often are requisitions reviewed?

• How do approvals work within your organization?

• How often are purchase orders created from requisitions?

• Who receives?

• Do you post encumbrance transactions?

• Does your organization need to have all products defined in the product list? Or do you want requestors 
to be able to request non-listed products?

• Does the requestor need to know any GL distribution information when making the request?

• Does the requestor need to know the vendor when making the request?

• Can the requestor use a vendor that is not listed in Accounts Payable?

• If vendor information or GL distribution information is missing, who is the contact person for 
questions?

WebPurchasing Setup Checklist
There are several tasks involved with setting up your WebPurchasing system. These tasks should be 
completed in the order below.

Create Security Groups – Use the Set up system security page in Administration in Accounts Payable 
to create group profiles for WebPurchasing users.

Create Users – Use the Set up system security page in Administration in Accounts Payable to create the 
user record and define the user’s security privileges, Windows authentication, and the type of access to 
WebPurchasing.

Create Approval Rules – On the Approval Rules page in Configuration in Accounts Payable, define the 
approval rules that route a requisition to the reviewers identified by your organization. All reviewers 
you select are required to approve, not just one.

Define Product Categories – Use the product category to group products into categories and 
subcategories. This makes it easier for users to locate the products they need on the Product List page. 
You can define product categories in Configuration in Accounts Payable and in WebPurchasing.

Define Products – Use the Products Setup page to create the products users can purchase. You can 
define products in Configuration in Accounts Payable and in WebPurchasing.

Configure Business Rules – On the Business Rules page in Configuration in Accounts Payable, specify 
the requirements and settings for WebPurchasing functionality.

Configure Tables – On the Tables page in Configuration in Accounts Payable, define WebPurchasing 
specific fields, such as requisition rejection reasons, unit of measure, and location.
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Create Attributes – On the Attributes page in Configuration in Accounts Payable, define specific 
attributes to be used in requisition reports and queries.

Security Group Setup
By creating a security group and assigning users, you determine the type of access a user has to 
WebPurchasing. Properly setting up security ensures that users can access only the areas that you specify. 
New Security groups are defined in Administration in Accounts Payable.

 Add a security group

1. From the navigation bar in The Financial Edge, click Administration. The Administration page 
appears.

2. Click Set up system security. The Set up system security page appears.
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3. Click New Group on the action bar. The New Group screen appears.

4. In the Group name field, enter a name for the user group. This name must be unique and no 
longer than 30 characters. We recommend you use a descriptive name that you can easily 
remember for each group. If you make a user with Supervisor rights a member of a security group, 
his Supervisor rights are not affected.

Note: When you create approval rules, you can specify what security groups have rights to use that 
approval. If your approvals are based on department, set up a security group for each department. 
For more information about approval rules, see “Define Approval Rules” on page 11.

5. In the Description field, enter a description of the user group that indicates the type of access the 
group has to WebPurchasing.

6. In the Group type field, select the type of group you want to create. Your selection changes the 
options that appear on the Group Privileges tab. Select “Standard” for users that access 
WebPurchasing and The Financial Edge. Select “WebPortal” for users that only access 
WebPurchasing and/or WebInvoicing.

Note: If a user is a member of the “Standard” group, but their user record indicates that they have 
access to online modules, they will be able to access the WebPortal. If the user is a member of a 
“Web Portal” group only, they will not have access to The Financial Edge.

7. In the System Components box, select a program or component. To restrict users from accessing 
the program, unmark the checkbox. With a box marked, a list of security privileges for that 
component appears in the Privileges box on the right.

8. In the Privileges box, unmark a checkbox to prevent the group from accessing that area of the 
program. Leave the checkbox marked to allow the group access.

9. To define additional levels of security, select a privilege and click Options. The Security Options 
screen appears.
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Note: If no additional security rights are available for the selected privilege, the Options button is 
disabled.

10. In the box on the left, select a security option. If the option has additional security privileges, they 
appear on the right.

11. Mark the checkbox in the View, Add, Edit, and Delete columns for the program areas the group 
can access.

12. Some privileges have miscellaneous options. Mark a checkbox to give the group access or unmark 
to deny access to a function.

13. When you finish, click OK to return to the New Group screen.

14. Although you can assign users to a security group by selecting the Group Members tab, we 
recommend you skip this section and add a user to a group from the Users screen. For more 
information on creating a user, see “User Security Setup” on page 5.

15. To return to the Set up system security page, click Save and Close.

User Security Setup
An individual user’s security privileges are determined by the group the user is assigned to. You add users 
to security and then define their levels of access by assigning them to security groups. Using groups 
ensures data consistency, integrity, and confidentiality by limiting access to records and functions to the 
users who need it. A user can be a member of multiple groups. User access to WebPurchasing is defined 
on the User screen in The Financial Edge.
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 Add a user to a security group

1. From the navigation bar in The Financial Edge, click Administration. The Administration page 
appears.

2. Click Set up system security. The Set up system security page appears.
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3. Click New User on the action bar. The New User screen appears.

4. In the User name field, enter the name the user will use to log into the program.

5. In the Description field, enter a full name or other information to identify the user.

6. In the Connection Options frame, mark Use FE7 Authentication if you want a user’s log in 
information for The Financial Edge to be separate from his workstation log in information.

a. If you mark Use FE7 Authentication, enter the user’s password in the Password field. 
Create a strong password that consists of at least eight characters that are a combination of 
letters and numbers.

b. Enter the password again in the Confirm field.

Note: The actual password does not display in the Password and Confirm fields. For privacy, 
only asterisks appear.

7. Mark Use Windows Authentication if you want a user’s log in information for The Financial 
Edge to be based on his Windows log in information. When users logged into a workstation 
through their Windows authentication access The Financial Edge, the Windows information is 
used to automatically log the user into the program.

Note: If you mark both the Use FE7 Authentication and Use Windows Authentication 
checkboxes, this affects only whether or not a password is stored for the user. The Financial Edge 
always tries Windows authentication first, but if for some reason that fails, The Financial Edge 
User name/Password screen appears.

To associate a user’s Windows authentication information with The Financial Edge, use the 
Login field to locate that user’s account on your network.

a. Click the binoculars in the Login field. The Select User Account screen appears.

b. In the List Names From field, select the system to which the user you want to select belongs.
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c. All members of the selected system appear in the Names box. Select the user you want to 
specify and click Add. The name appears in the Add Name field.

d. Click OK. You return to the Security User screen where the user now appears in the Login 
field.

8. In the User Type field, to enable WebPurchasing for the user, you must select either “User can 
only access online modules” or “User can access The Financial Edge and online modules”.

9. In the Groups for <Your Organization> frame, to assign the user full access to the programs, 
mark Supervisor rights. To restrict access to certain security groups, mark Selected group rights.

10. If you mark Selected group rights, select the user’s group from the Not a member of box and 
click the single right arrow to move the group to the Member of box.

11. To grant the user the right to change his password, mark User can change password.

12. To grant the user the right to change his options, mark User can change User Options. To set 
options, click Set this user’s options after saving the user to open the user’s options screen. At the 
bottom of the Options screen, you can click Copy From to copy another user’s options. Using this 
feature helps keep data consistent.

13. If you have the optional module Advanced Security, select the Account Security tab.

14. In the Account access field, select the access level you want the user to have. If you select “Allow 
access to selected Accounts” or “Prevent access to selected Accounts”, mark Query, Range, or 
Selected.

• If you mark Query, enter a query name in the Query Name field or click the binoculars to 
locate the query.

• If you mark Range, in the Start Account Number column, enter a starting account number. In 
the End Account Number column, enter an ending account number. The account descriptions 
appear from the account records.

Tip: With the optional module Advanced Security, you can use masking for a range of selected 
accounts. You can also mask one or more characters of an account segment using the asterisk in 
place of the character. For more information about masking, see the Configuration Guide for 
General Ledger.

• If you mark Selected, enter an account number in the Account Number column. Repeat for 
each account the user should be able to access.
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15. If you have the optional modules Advanced Security and Projects and Grants, select the Project 
Security tab to define additional security for projects.

16. In the Project access field, select the projects you want the user to be able to access. If you select 
“Allow access to selected Projects” or “Prevent access to selected Projects”, mark Query, Range, 
or Selected.

• If you mark Query, in the Query Name field, enter a query name or click the binoculars to 
locate the query.

• If you mark Range, enter a starting project number in the Start Project Number column or 
click the binoculars to locate a number. In the End Project Number column, enter an ending 
project number or click the binoculars to locate a number. The project descriptions appear from 
the project records.

• If you mark Selected, enter a project number in the Project Number column. Repeat for each 
project the user will access.

17. If you have the optional module Advanced Security and the program Accounts Payable or Payroll, 
select the Signature Security tab.

18. Mark the Choices? checkbox to make a signature available for use.
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19. If you have the optional module Purchase Orders and use WebPurchasing, select the Online 
Security tab.

20. In the Online Systems box, mark WebPurchasing to give the user access to WebPurchasing. 

Note: You can also grant users access to WebInvoicing from this screen. For more information 
about WebInvoicing, see the WebInvoicing User Guide.

21. In the Department field, select the user’s primary department.

22. To allow the user to approve or reject requisitions, mark Can approve Requisitions.

23. To allow the user to approve his own requisitions, mark Can self-approve Requisitions.

24. To restrict the amount a user can self-approve, enter the maximum amount in the Requisition self 
approval limit field.

Note: Requisitions under self-approve limits are automatically approved.

25. To prevent the user from creating receipts for himself or others, mark Cannot create Receipts.

26. To allow the user to create receipts for his own requisitions, mark Can create Receipts for own 
Requisitions.

27. To allow the user to create receipts for all requisitions, mark Can create Receipts for all 
Requisitions.

28. To allow the user to view all requisitions, mark Can view all Requisitions.

29. To allow the user to edit other users’ information on the My Account page in WebPurchasing, 
mark Can edit My Account information for other users.
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30. If you have the optional module Advanced Security and the program Payroll, select the Employee 
Security tab.

31. In the Employee access field, select the employees you want the user to be able to access. If you 
select “Allow access to selected Employees” or “Prevent access to selected Employees”, mark 
Query, Range, or Selected.

• If you mark Query, in the Query Name field, enter a query name or click the binoculars to 
locate the query.

• If you mark Range, enter a starting employee in the From Employee column or click the 
binoculars to locate an employee. In the To Employee column, enter an ending employee or 
click the binoculars to locate an employee. The employee IDs appear from the employee 
records.

• If you mark Selected, enter an employee in the Employee Name column. Repeat for each 
employee the user will access.

32. To save the user security settings and return to the Set up system security page, click Save and 
Close.

Define Approval Rules
Approval Rules route a requisition to the reviewers identified by an organization. The Approval Rule table 
is designed to be flexible enough to accommodate your needs. For example, your organization may require 
one set of reviewers for normal supply orders, a different set of reviewers for capital expenditures, and yet 
a different set of reviewers for computer-related purchase. Approval rules are defined in Accounts Payable 
in Configuration. When a user selects an approval rule on his requisition and submits it, the requisition is 
forwarded to the right reviewers in the right order. Approval histories on all requisitions are maintained 
and available to users. All reviewers you select are required to approve, not just one.

Note: When a user has rights to self-approve up to a certain amount, his requisitions are automatically 
approved up to that amount.

If you have both WebPurchasing and WebInvoicing installed, you can designate which system should use a 
specific approval rule. In addition you can set up distinct user groups for each systems approval rule. For 
more information about user groups, see “Security Group Setup” on page 3.
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 Define approval rules

1. On the Configuration page, click Approval Rules. The Approval Rules page appears.

2. Click New. The New Approval Rule screen appears.

3. In the Approval Rule Name field, enter the name of the approval rule, for example “IT 
Purchases”.

Note: Be very particular of how you name an approval rule. This is what the user sees in 
WebPurchasing.

4. In the Description field, enter the a description of the approval rule, for example, “All IT requests 
needing approval”.

5. In the Approval Rule Type field, select the module(s) with which you want this approval rule 
associated, for example “WebPurchasing”.

Note: This field appears only if you have both WebInvoicing and WebPurchasing.

6. In the Approve above column, enter the requisition amount selected users can approve, for 
example, a selected approver can approve purchases over $100.00. The default amount in the first 
row is $0.00. Enter other amount thresholds in each following row. For example, if you enter 
$500.00 in the second row, reviewers on the first row can approve purchases up to $499.
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7. To select the users for each row, in the Approvers column, click the binoculars. The Select 
Approvers screen appears. The Available approvers box lists users given approval rights in 
Administration for Accounts Payable. For more information, about defining approval settings for 
user accounts, see “User Security Setup” on page 5.

8. In the Available approvers box, select the approvers for each row and move them to the Selected 
approvers box.

Note: If a reviewer leaves your organization make sure to remove that user from each approval 
rule of which he was a member.

9. To add the approvers to each row and return to the New Approval Rule screen, click OK.
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10. To define the security groups that will have the ability to use the approval rule, click the Group 
Access tab. The Group Access screen appears.

11. The Available groups box lists security groups with access to WebPurchasing. For more 
information about security groups, see “Security Group Setup” on page 3.

12. In the Available groups box, select the security groups for this approval rule and move them to 
the Assigned groups box.

13. To save the approval rule, click Save and Close.

Define Product Categories
The product category page is where you define categories and subcategories. Product categories make it 
easier for users to locate the products they need on the Product List page in WebPurchasing. You can 
define a product category in Accounts Payable on the Configuration page. A product does not need to be 
assigned to a category.

 Define a product category in Accounts Payable

1. On the Configuration page, click Categories. The Categories page appears.
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2. Click New. The New Category screen appears.

3. In the Category Name field, enter a name for the category, for example, “Computer Hardware”.

4. Mark Active, to display the category throughout the system.

5. In the Notes field, enter a description of the category, for example, “Computer equipment used 
throughout the organization”.

6. In the Subcategory Name column, enter the name of a subcategory, for example, “Cables”.

7. In the Notes column, enter a description of the subcategory, for example, “Network and device 
cables”.

8. Mark Active, to display the subcategory throughout the system.

9. To save the category and return to the Categories page, click Save and Close.

Define Products
You create products for items or services you routinely purchase from vendors. The benefit of creating a 
product is that it is more efficient than entering the same product information again and again in purchase 
orders. Using products also provides consistency in product information you enter in each purchase order. 
Once a product is entered into the system, you can edit information or delete the product, as long as the 
product is not in use by one or more line items.

Note: Products can be goods (office supplies) or services (consulting). For a product that is a service and 
will be receipted over time, we recommend defining the unit price per session and the quantity as more 
than one. For each service, you would create a receipt for the number of sessions or hours purchased and 
the unit cost per session or hour.

You can create products in Accounts Payable if you have the optional module Purchase Orders. If you do 
not have access to Accounts Payable, you can create products in WebPurchasing. The products you define 
appear on the Product List page in WebPurchasing.

For steps to add a product record:

• in Accounts Payable, see “Define a Product in Accounts Payable” on page 16.
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• in WebPurchasing, see “Define Products in WebPurchasing” on page 22.

Define a Product in Accounts Payable

You can define products in Accounts Payable if you have the optional module Purchase Orders.

 Define a product in Accounts Payable

1. On the navigation bar, click Configuration. The Configuration page appears.

2. Click Products. The Products page appears.
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3. On the action bar, click New. The New Product screen appears.

Tip: You can use default sets to define common information for products. For a new product, you 
can select Product, Load Defaults from to select a default set of information to copy. For more 
information about using default sets, see the Program Basics Guide for The Financial Edge.

4. In the Product ID field, enter a unique ID for the product.

5. In the Description field, enter a description to help identify the product.

Note: Be mindful of the information you enter in the Product ID and Description fields. This 
information helps users search for products in WebPurchasing.

6. In the Unit of measure field, select the unit of measure to use when measuring the product’s 
quantity. The entries available in this field are pulled from the Unit of Measure table defined in 
Configuration. You can quickly access the table and add new units of measure by clicking Unit of 
measure, which is a link as well as the name of the field. For more information about the Unit of 
Measure table, see “Define Tables” on page 27.

Tip: In fields containing table entries defined in Configuration, you can add a new entry by simply 
typing it in. The program prompts you to add the entry to the table.

7. In the Standard unit cost field, enter the price of a single unit.

8. In the Quantity decimals field, enter the number of decimal places to allow when defining the 
quantity of a product.

9. In the Receiving location field, select a location. Receiving locations are pulled from a code table 
defined in Configuration. You can quickly access the table and add new locations by clicking 
Receiving location, which is a link as well as the name of the field. For more information about 
the Location table, see “Define Tables” on page 27.
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10. In the Vendor name or Vendor ID field, enter the name or ID of the vendor or use the binoculars 
to locate a vendor.

Note: Whether you enter the name or ID depends on your selection for General Options on the 
Records tab of the Options screen.

11. In the Vendor Part # field, enter the number assigned to this product by the vendor.

12. In the Notes field, enter any additional information about the product.

13. If you do not want this product to appear as an available option when defining line items, mark Do 
not allow this product to appear on new line items.

14. To save the product and return to the Products page, click Save and Close.

 Add a product pricing schedule

On the Pricing Schedule tab, you can specify price changes to take effect on certain dates or within a 
certain quantity. For example, if you have a price increase that starts January 1, you can create a 
pricing schedule that automatically increases the price for that product on that date. When a product is 
used on a purchase order, the price defined in the pricing schedule that is effective as of the purchase 
order’s transaction date defaults into the purchase order.

1. From an open product, select the Pricing Schedule tab.

2. To add a new pricing schedule, click New Pricing Schedule on the action bar. The Add a Pricing 
Schedule screen appears.

3. In the Prices are effective as of field, enter the beginning date for this price change. The field 
defaults to the current date.
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4. In the Description field, enter a description for this pricing schedule.

5. In the Pricing field, select “Use a single unit price for all quantities” or “Base unit price on 
quantity”.

If you select “Use a single unit price for all quantities”, in the grid, enter the new unit price. If you 
select “Base unit price on quantity”, the Minimum Quantity, Maximum Quantity, and Unit 
Price columns appear in the grid. Enter the maximum quantity eligible for the first price range. 
The minimum quantity defaults to 0.00. In the Unit Price column, enter the per unit price for those 
quantities. Repeat for additional quantity ranges.

6. To save the pricing schedule and return to the Pricing Schedule tab, click OK.

7. To save the product record and return to the Products page, click Save and Close.

 Assign a product category to a product

On the Categories tab, you can assign a category and subcategory to a particular product. Product 
categories make it easier for users to locate products on the Product List page in WebPurchasing. For 
more information about product categories, see “Define Product Categories” on page 14.

1. From an open product, select the Categories tab.

2. In the Categories column, mark the category you want to assign to the product.

3. If the selected category has subcategories, they appear in the Subcategories column. Mark the 
subcategory you want to assign to the product.

4. To save the product record with the selected category and return to the Products page, click Save 
and Close.
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 Add a product attribute

Use the Attributes tab to record additional information about a product. You can report on products 
with specific attributes. You can also use product attributes as filters in other areas of Accounts 
Payable, such as Query and Reports. For more information about attributes, see “Define Attributes” on 
page 28.

1. From an open product, select the Attributes tab.

2. In the Attribute Type field, you can filter the attribute types appearing in the grid.

3. In the Attribute Type column, select an attribute. Attribute types are established in Configuration.

4. In the Description column, enter or select a value for the attribute. The available options depend 
on how the attribute type is defined.

5. In the Date column, enter the date you add the attribute.

6. The Required column is for informational purposes only. You can make an attribute required in 
Configuration when defining attribute types. If required, the attribute automatically appears on the 
product and you must enter a description for the attribute.

7. Enter any additional comments or more detailed information in the Comments column. You can 
enter free-form text in this column.

8. To return to the Products page, click Save and Close.
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 Add a default distribution to a product

When adding a new product, you should establish default account distribution information for it if 
possible. You can designate the debit accounts, the percent to distribute to each account, and whether 
to further classify the distributions using projects, classes, and transaction codes. If you define default 
distributions on the product, you will not have to enter those details every time you use the product.

1. From an open product, select the Distribution tab.

Tip: To move between rows in a grid column, press CTRL + the up or down arrow key.

2. In the DR Account Number column, enter the debit accounts for the distribution. You can use the 
small binoculars to search for an account segment or use the large binoculars to search for an 
account number. When you enter a valid debit account number, the description appears 
automatically in the DR Account Description column.

You can also use a default account distribution defined in Configuration. Click Load Distribution 
and select From Table.

3. Enter the percentage of the distribution in the Percent column. You can manually enter 
percentages for each account or you can click Distribute Evenly to distribute percentages equally 
among the selected accounts.

4. If you have the optional module Projects and Grants, enter a project ID number in the Project ID 
column, or use the binoculars to search for a project ID. When you enter a valid project ID number, 
the description appears automatically in the Project Description column.

5. In the Class column, select a class for the distribution.

6. If you have the optional module Projects and Grants and have defined transaction codes, 
additional columns appear based on the number of transaction codes you have defined. In the grid, 
select a value for each transaction code.

7. To enter different transaction distributions for the debit accounts in a distribution row, select the 
distribution row and click Distribution. The Debit Transaction Distribution screen appears.
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You can also use this screen to split transaction distributions among multiple projects, classes, or 
transaction codes for a single debit account. When you have finished entering information, click 
OK to return to the product record Distribution tab.

Note: On the Debit Transaction Distribution screen, you can click Load Distribution to select a 
transaction distribution defined in Configuration in Accounts Payable.

8. To attach transaction attributes to an account in the distribution, select the account and click 
Attributes on the action bar below the grid. When you have finished entering information, click 
OK to return to the product record Distribution tab.

9. To save the product and return to the Products page, click Save and Close.

Define Products in WebPurchasing

If you do not have access to The Financial Edge, but have rights to add products, you can create products 
in WebPurchasing.

 Define a product in WebPurchasing

1. Log in to WebPurchasing. The Home Page appears.
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2. Under Purchasing Setup, click New Product. The New Product page appears.

3. In the Product ID field, enter a unique ID for the product.

4. In the Description field, enter a description to help identify the product.

Note: Be mindful of the information you enter in the Product ID and Description fields. This 
information helps users search for products on the Product List page.

5. To make this product available throughout WebPurchasing and Accounts Payable in 
The Financial Edge, mark Active.

6. In the Vendor Name field, enter the name of the vendor, or use the binoculars to locate the vendor.

7. In the Vendor Part # field, enter the vendor part number for this particular product.

8. In the Unit of Measure field, select the unit of measure to use when measuring the product’s 
quantity. The entries available in this field are pulled from the Unit of Measure table defined in 
Accounts Payable in Configuration.

9. In the Standard Unit Cost field, enter price of a single unit.

10. In the Quantity Decimals field, enter the number of decimal places to allow when defining the 
quantity of a product.

11. In the Receiving Location field, select a location. Receiving locations are pulled from a code table 
defined in Accounts Payable in Configuration.

12. In the Notes field, enter any additional information about the product.

13. In the Display Details frame:

• In the List detail box, enter a short description of the product. This description appears beneath 
each product listed on the Product List page.
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• In the Dialog detail box, enter a longer description of the product. You can view this description 
when you click a product link on the Product List page.

14. In the Categories Associated frame, select the category and subcategory associated with the 
product and click Assign. The category and subcategory appear in the box to the right.

Note: To remove the category and subcategory associated with the product, select the item from 
the box and click Remove.

15. In Pricing Schedules, you can specify any price changes that take effect on certain dates. To add a 
new pricing schedule, click New, the Pricing Schedule screen appears.

• In the Effective as of field, enter the date the price change takes effect or select a date by 
clicking the calendar.

• In the Description field, enter a description of the pricing schedule.

• Select whether to “Use a single unit price for all quantities” or “Base unit on Quantity”.

If you select “Use a single unit price for all quantities”, in the grid, enter the new unit price. If 
you select “Base unit price on quantity”, the Minimum Quantity, Maximum Quantity, and 
Unit Price columns appear on the screen. Enter the maximum quantity eligible for the first price 
range. The minimum quantity defaults to 0.00. In the Unit Price column, enter the per unit price 
for those quantities. Repeat for additional quantity ranges.

• To save the new pricing schedule and attach it to your product, click Save.

16. In Attributes, you can add any additional information about the product. To add a new product 
attribute, click Add, the New Attribute screen appears.
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Note: The Add button is disabled if no product attributes were defined in Configuration. For more 
information about product attributes, see “Define Attributes” on page 28.

17. In Distribution, you can establish default account distribution information for the product. You 
can designate the debit accounts, the percent to distribute to each account, and whether to further 
classify the distributions using projects, classes, and transaction codes.

18. From the drop-down list, select “Summary View” or “Detail View” and click Add.

If you select “Summary View”, 

a. In the Amount field, enter the percentage to distribute to the account. You can manually enter 
percentages for each account or you can click Distribute Evenly to distribute percentages 
equally among the selected accounts.

b. In the GL Account field, enter the debit account for the distribution. You can use binoculars 
to search for an account number. When you enter a valid debit account number, the 
description appears automatically to the left of the account number field.

c. To add additional debit accounts, click Add.

If you have the optional module Projects and Grants and select “Detail View”,

a. In the Amount field, enter the percentage to distribute to the account. You can manually enter 
percentages for each account or you can click Distribute Evenly to distribute percentages 
equally among the selected accounts.

b. In the GL Account field, enter the debit account for the distribution. You can use the 
binoculars to search for an account number. When you enter a valid debit account number, 
the description appears automatically to the left of the account number field.

c. Enter the percentage to distribute to the project in the Percent column.

d. Enter a project ID number in the Project field or use the binoculars to search for a project ID.
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e. Select a class for the distribution in the Class field.

f. To add additional debit accounts, click Add.

Note: If you have the optional module Projects and Grants and have defined transaction codes, 
additional fields appear based on the number of transaction codes you have defined. Select a value 
for each transaction code. For more information on transaction codes, see “Transaction Codes” in 
Configuration Guide for General Ledger.

19. To save the product click Save. The new product appears on the Product Setup page.

Configure Business Rules
Business rules help you customize standard procedures and requirements to suit your organization. 
Business rules affect all users and are usually defined by the system administrator. With Requisition 
business rules, you can specify requirements and settings for WebPurchasing functionality. To change 
business rules, from the Configuration page in Accounts Payable, click Business Rules. The Business 
Rules page appears. For more information about business rules, see the Business Rule Configuration 
chapter of the Configuration Guide for Accounts Payable. 
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The following is a list of business rules specific to WebPurchasing.

Define Tables
A table is a field in which you can predefine entries to save time and promote consistency for your data 
entry. Tables are set up and maintained in The Financial Edge. WebPurchasing uses several tables to 
successfully create requisitions and purchase orders. You can add or delete table entries depending upon 
your organization’s needs. The following is a list of tables specific to WebPurchasing.

 Add a table entry

1. On the navigation bar, click Configuration. The Configuration page appears.

Business Rule Description
Require a General Ledger account distribution With this business rule marked, you can choose if or 

when a General Ledger account distribution is 
required when creating a requisition.

Require a vendor With this business rule marked, you can choose if or 
when a vendor is required when creating a 
requisition.

Allow the unit price and quantity to be edited 
on requisition line items

Mark this business rule if you want to allow 
reviewers to edit the unit price and quantity on 
requisition line items. This rule also applies to the 
user running the purchase order process.

Reroute updated requisitions to the beginning 
of the approval process after changes

If you marked Allow the unit price and quantity to 
be edited on requisition line items, then mark this 
business rule if you want to reroute updated 
requisitions to beginning of the approval process.

Allow users to change the unit price of items in 
their Shopping Cart

Mark this business rule if you want to grant users the 
ability to change the unit price of items in their 
Shopping Cart.

Table Description
Buyers The individuals responsible for buying products.

Cancellation Reason Indicates the reason a line item on a requisition is rejected. This 
table is used for requisitions that are invalid but have been fully 
approved.

Department The department for which the order is being placed.

FOB Freight On Board. The point at which a customer assumes 
ownership of an order.

Location The location where an order is delivered.

Rejection Reason The reason a requisition line item is rejected.

Shipping Codes The shipping method used for an order; for example, UPS, 
Fed-Ex, or US Mail.

Units of Measure The measurement of a particular product; for example, box, 
pallet, case.
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2. Click Tables. The Tables page appears.

3. In the box on the left, select the table in which to add the new table entry. Table entries appear in a 
grid on the right.

4. Select New Table Entry. The New Table Entry screen appears.

5. In the Description field, enter a description for the new table entry. Depending on the field you 
add, you may be asked to enter other fields, such as Short Description or Email address.

6. If you want to make the new table entry inactive, mark Inactive. When you make a table inactive 
it will not appear in WebPurchasing. For example, if you make a specific a Unit of Measure table 
entry inactive, such as “box”, you cannot use that table entry to define the measurement of a 
particular product.

7. To save the new table entry and return to the Tables page, click OK.

Note: Table entries can be edited at any time or deleted if they are not used on any records.

Define Attributes
An attribute is a reporting tool you use to group information based on a common theme. With attributes 
defined, you can filter information to your specifications. Attributes are set up and maintained in 
The Financial Edge. You can define specific requisition attributes for use in WebPurchasing. For 
example, a school might need a “Classroom” requisition attribute. The information is maintained on the 
requisition and can be used in requisition reports and queries.

 Add an attribute

1. On the navigation bar, click Configuration. The Configuration page appears.
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2. Click Attributes. The Attributes page appears.

3. In the box on the left, select the type of attribute to add, for example, Requisition. The attributes 
grid appears on the right.

4. In the Attribute Type column, enter a description of the attribute, for example, “Classroom”.

5. In the Data Type column, select the field’s format type. Data types include text, date, yes/no, 
number, currency, and table.

Note: If you define the data type as a table, you can select an existing table or create a new one.

6. If you select Table as the data type, enter a table name in the Table Name column.

7. To make the attribute required on each record, mark Required.

Note: Attributes can be edited at any time or deleted if they are not used on any records.

8. To require a unique attribute for each record, mark Unique.

9. When you exit the attributes grid, your attributes are saved automatically.
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2CHAPTER
Use WebPurchasing 
Online

In this chapter

 “Access WebPurchasing” on page 32

 “Create Requisitions” on page 36

 “View Requisition Records” on page 44

 “Approve and Reject Requisitions” on page 47

 “Create Receipts” on page 48

Creating requisitions through WebPurchasing involves searching for the products you want to purchase, 
creating the requisition, and submitting the requisition for approval. Once you create a requisition you can 
update it online. You can also save the products you use most frequently as “favorites” to speed the process 
of creating future requisitions. This chapter details the requisition order process in WebPurchasing, from 
creating and submitting requisitions, to approving or rejecting requisitions, to creating receipts for 
purchase orders.
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Access WebPurchasing
During the install process, your system administrator defined the URL for The Financial Edge WebPortal 
website. Once you access the WebPortal website, via this URL you can log in using your user name and 
strong password. If you are denied access, you can reset your password.

WebPurchasing supports Internet Explorer 7 or higher on the PC and with Firefox 3 or higher on the PC 
and Macintosh. Other browsers are not supported and may not operate or display information correctly in 
WebPurchasing.

Home Page

When you log into the WebPortal, your Home page appears. To use WebPurchasing, you must have 
specific security rights. Your security settings determine which tasks appear on the Home page. Therefore, 
the Home page will look different based on each user’s security settings. Your system administrator 
establishes security settings in The Financial Edge in Administration.

Note: If you have rights to both WebPurchasing and WebInvoicing, the Home page displays tasks related 
to both applications.
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• Purchasing – The Purchasing list contains links to all purchasing tasks. Fore more information on 
purchasing tasks see “Create Requisitions” on page 36.

• Purchasing Setup – The Purchasing Setup list contains links to tasks used to define products categories 
and products available for purchase. For more information about purchasing setup tasks, see 
“WebPurchasing Setup” on page 1.

• Requisitions – The Requisitions lists contains links to all requisition tasks. For more information about 
requisition tasks see, “Create Requisitions” on page 36.

• Receive – The Receive list contains links to all receipting tasks. For more information on receipts, see 
“Create Receipts” on page 48.

Note: To close WebPurchasing, always click Log Out. Do not close the browser because the program 
considers the license you are using active until the session expires 40 minutes later. If you have multiple 
users accessing WebPurchasing, this may prevent someone from logging on.

My Account Page

If you have access to WebPurchasing or WebInvoicing, you can specify personal settings for your account. 
For example, you can choose to be notified when a requisition is submitted for your approval, or change 
your email address.

 Manage your WebPurchasing account

1. From WebPurchasing, click My Account. Your account page appears.

2. In the Email field, enter the email address you want to receive notifications.

3. Mark one or more checkboxes to specify when to receive notifications.
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• Mark My requisition is approved by any reviewer if you want email notification when a 
requisition you submitted has been approved by any reviewer.

• Mark My requisition is approved by final reviewer if you want email notification when a 
requisition you submitted has been approved by the final reviewer.

• Mark My requisition is rejected if you want email notification when a requisition you 
submitted has been rejected.

• Mark My Purchase Order is created if you want email notification when a purchase order is 
created for a requisition you submitted.

• Mark My approval is required for a requisition if you want email notification when an 
requisition requires your approval.

4. If you will be out of the office for a period of time and want requests submitted for your approval 
forwarded to someone else, mark Turn on Out of Office processing and select the person who 
will receive the requests in the Forward requests submitted for my approval to field.

Note: In cases where all of the current reviewers are out of the office, a notation will be added in the 
Reviewer column and in the Current Reviewer field of the requisition, indicating the reviewer is out of 
the office.

5. To save your information, click Update My Account. You can update or change this information 
at any time.

My Favorites

You can save the products you use most frequently as favorites to speed the process of creating future 
requisitions. Once you save a product as a favorite, it is stored on the My Favorites page. You can remove 
a product from the My Favorites page at any time by clicking Remove from Favorites.

 Save a favorite product

1. From the WebPurchasing home page, click Go Shopping. You can access this link from the 
Activities tab or the Purchasing frame on the home page. The Product List page appears.
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2. Locate the products you want to include in the favorites list. You can use search options under the 
Search the Product List on the left side of the page.

3. Once you locate the product you want to save as a favorite, click Add to Favorites. A 
confirmation message “Product Added to Favorites” appears above the product price.

4. The confirmation message is also a hyperlink. When you click the link, the My Favorites page 
appears. Verify the product you selected appears on the page.

5. You can remove a product from the My Favorites page by clicking Remove From Favorites.



CH A P T E R 236 .
Create Requisitions
Creating requisitions through WebPurchasing involves searching for the products you want to purchase, 
confirming the order, creating the requisition, reviewing the requisition, and submitting the requisition for 
approval. When a requisition is submitted, an email notification is sent to your reviewers for approval. 
Based on the settings defined on your My Account page, you may receive email notifications when your 
requisition is approved or rejected. Once you create a requisition you can update it online until it is 
submitted. 

 Search for products to purchase

1. From the WebPurchasing home page, click Go Shopping. You can access this link from the 
Activities tab or the Purchasing frame on the home page. The Product List page appears.

This page lists all the products defined in Accounts Payable and represents a catalog of products 
frequently requested by your organization. Click a product link to view additional product 
information.

2. Search for the products you want to request. You can scroll through all the items on the product list 
or use the search options under the Search the Product List on the left side of the page.
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• You can search for products by entering information in the Product Description, Vendor, 
Vendor Part No, or Product ID fields or selecting a Category and Subcategory and clicking 
Search.

Note:  When you search for products or vendors, the search results display all records that contain 
your criteria, regardless of where it falls in the word. For example, if you enter “Board” in the 
Product Description field and click Search, the results could include “Boards – 2x4”, “Boarding 
Services”, and “Dry Erase Board”. Wildcards are not needed for searching.

• In the Sort by field, you can sort the product list by Product Description, Product ID, Price: 
Low to High, Price: High to Low, or Vendor. 

3. Enter the quantity of the product you want to purchase in the Qty field.

4. To add the item to your cart, click Add to Cart.

Note: To view the items you have requested so far, including the quantity, price, and the total 
purchase amount, click the My Cart tab. 

 Request a one-time product

If you need to purchase a product that is not on the product list and should not be added to the product 
list, click Request One-time Product on the Activities tab. The product information added to the 
Request One-time Product page appears on your shopping cart and your requisition.

1. From the Activities tab on the Product List page, click Request One-time Product. The Request 
One-time Product page appears.

2. In the Product Description field, enter a description to help identify the product.

3. Enter the quantity of the product you want to purchase in the Quantity field.
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4. In the Unit of Measure field, select the unit of measure to use when measuring the product’s 
quantity. The entries available in this field are pulled from the Unit of Measure table defined in 
Configuration in Accounts Payable.

5. In the Unit Price field, enter the price of a single unit.

6. In the Notes field, add any additional information about this product.

7. In the Select a Vendor field, enter the name or ID of the vendor or use the binoculars to locate a 
vendor.

8. If the vendor is not in the system, enter the vendor name and contact information in the Can’t 
Find a Vendor? frame.

9. To add the product to your cart, click Add to Cart. A link appears at the top of the page notifying 
you that the product was added to your cart. Click the link to return to the My Cart page.

 Confirm the order

Once you have selected the products you want to purchase on the Product List page, confirm your 
order on the My Cart page.

1. From the Product List page, click View My Cart under the Activities tab. The My Cart page 
appears. This page lists the products you have requested so far and the total price of the products 
selected.
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2. Verify the information is correct. If you make any changes, click Update Cart. 

• In the Quantity you can change how many items you want to order.

• To change a product’s Unit Price, you must have the appropriate security rights.

Note: If you select a product subject to a pricing schedule, the Unit Price field is disabled and 
cannot be edited. An asterisk appears next to the field. For products with pricing schedules that 
change over time, the unit price for the current time period is selected. For products with pricing 
schedules based on amount, make sure you have the correct unit price for the quantity you request. 
In the Quantity field, enter the number of items you want to order and click Update Cart.

• To remove a product from your cart, mark the appropriate checkbox under the Remove column 
and then click Update Cart.

3. To add other products to this order, click Continue Shopping to return to the Product List page.

 Create the requisition

1. When you complete your shopping, click Create Requisition. The Create Requisition page 
appears.

On this page you can verify your product selections, edit each line item in the grid, and add a 
vendor to each line item.
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2. In the Approval Rule field, select the approval rule you have rights to use. If you have self 
approval rights, this field defaults to “Self Approve”, however you can change the rule. Click 
Show Details to view more information about the selected approval rule.

3. In the Description field, enter any additional information about the requisition. This information 
appears on the requisition record in Accounts Payable.

4. Select Add Attachments to access the Attachments screen. From here you can add an attachment 
to a requisition record. This helps ensure that all supporting documentation associated with a 
purchase request is included in the approval process. 

5. To make changes to a line item on the requisition, click the Edit hyperlink that appears in the last 
column on the grid. The Edit Line Item page appears.

6. Enter any additional comments or more detailed information about the product in the External 
Notes and Internal Notes boxes. Any information you enter in the External Notes box appears on 
the purchase order. Any information you enter in the Internal Notes box appears on the 
requisition line item.

7. In the Search for a Vendor field, click the binoculars to locate a vendor.

8. If the vendor is not in the system, enter the vendor name and contact information in the Suggest 
Another Vendor section.

9. Entering information in Purchase Order Line Item Information is optional.
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• In the Date Required field, enter the date the item must be delivered.

• In the Department field, select the department for which the order is being placed.

• In the Ship via field, select the shipping method to use.

• In the Deliver to field, select the individual who should receive the item.

• In the Ship to field, select the location where you want the item sent.

• In the Freight on board field, select the point where your organization assumes ownership of 
the order.

• In the Buyer field, select the individual responsible for buying the product.

10. In the Distribution frame, you can select the account or project distribution and view budget 
information.

11. From the drop-down list, select “Summary View” or “Detail View” and click Add.

If you select “Summary View”:

a. In the Amount field, enter the amount to distribute to the account. You can manually enter an 
amount for each account or you can click Distribute Evenly to distribute an amount equally 
among the selected accounts.

b. In the GL Account field, enter the debit accounts for the distribution in the second field. You 
can use binoculars to search for an account number. When you enter a valid debit account 
number, the description appears automatically to the left of the account number field.

c. To add additional debit accounts, click Add.

If you select “Detail View”:

a. In the Amount field, enter the amount to distribute to the account. You can manually enter 
percentages for each account or you can click Distribute Evenly to distribute percentages 
equally among the selected accounts.

b. In the GL Account field, enter the debit accounts for the distribution in the second field. You 
can use the binoculars to search for an account number. When you enter a valid debit account 
number, the description appears automatically to the left of the account number field.

c. In the Amount field, enter the amount to distribute to the project. You can manually enter an 
amount for each account and project or you can click Distribute Evenly to distribute an 
amount equally among the selected accounts and projects.

d. Enter the percentage to distribute to the project in the Percent column.

e. Enter a project ID number in the Project field or use the binoculars to search for a project ID.

f. Select a class for the distribution in the Class field.

g. To add additional debit accounts, click Add.
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Note: If you have the optional module Projects and Grants and have defined transaction codes, 
additional fields appear based on the number of transaction codes you have defined. Select a value 
for each transaction code. For more information on transaction codes, see “Transaction Codes” in 
the Configuration Guide for General Ledger.

12. To check account spending against the budget, click Check Budget. The Budget View screen 
appears. You can view what the budget forecast for the selected account and what was actually 
budgeted for that account. This screen allows you to see when you are over budget and plan 
accordingly.

13. To use default account distributions, click Load Distribution. The Default Distributions screen 
appears. Select a distribution from the list and the distribution information appears in the 
Distribution frame of the Edit Line Item page.

14. To copy specific information from the current line item to other line items on the requisition, click 
Copy Line Item Info. The Copy Line Item Information screen appears. This screen lists each field 
on the Edit Line Item page.
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15. Mark the checkbox to copy information from the current line item to other line items on the 
requisition. For example, mark Vendor Information to copy the vendor information from the 
current line item to the other line items on the requisition.

16. To return to the Edit Line Item page, click OK.

17. To save the changes made to the line item, click Save. The changes made to the line item appear 
under the History of Changes frame.

18. To return to the Edit Requisition page, click Return to Requisition. Any changes made to a 
specific line item now appear on the requisition. For example, if you copied vendor information 
from a specific line item, the vendor information would appear on the remaining line items on the 
requisition.

19. To save changes made to the requisition, click Save. The changes made to the requisition appear in 
the History of Changes frame.
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20. When you complete your changes to the requisition, click Submit Requisition. A confirmation 
message appears. 

Note: Based on the settings defined on the My Account page, you may receive email notifications 
when your requisition is approved or rejected. For more information about defining email 
notifications for your account, see “My Account Page” on page 33.

21. Click the Home tab to return to the Home page.

View Requisition Records
Once requisitions are submitted for approval, you can view requisitions you created or the requisitions 
created by all users if you have the appropriate security rights. You can view when the requisition was 
created, who created the requisition, the requisition amount, and the approval status.

 View requisitions

1. From the WebPurchasing Home page, click All Requisitions or My Requisitions.

• When you click All Requisitions, the All Requisitions page appears. From this page you can 
view all the requisitions submitted by every user in your organization.
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Note: To view all requisitions, you must have the appropriate security rights that are defined in 
Accounts Payable. For more information about user security see, “User Security Setup” on page 5.

• When you click My Requisitions, the My Requisitions page appears. From this page you view 
all the requisitions you created.

2. To view a specific requisition, click View. The View Requisition page appears.
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Note: When the item has been ordered, the status changes to “Ordered”.

3. To view a specific line item within the requisition, click View. The View Line Item page appears.

The View Line Item page displays specific details about a selected line item, including vendor 
information, purchase order information, and history information. In addition, you can display a 
summary or detailed view of the GL distributions applied to the line item.

4. To copy the entire requisition click Copy Requisition. A requisition only has to have been saved 
in order to copy it. When you copy a requisition, a new requisition is created and includes the same 
items from the previous requisition. You can add more items to the new requisition or submit it for 
approval as is.



US E WEBPU R C H A S I N G ON L I N E 47.
Note: If you set your business rules to require GL distribution or a vendor on a requisition, the 
requisition cannot be copied.

Approve and Reject Requisitions
To approve and reject requisition orders, you must have security rights. The Supervisor can establish 
security settings for groups of users in Administration. For more information about setting up 
WebPurchasing security, see “User Security Setup” on page 5. 

 Approve a requisition

1. From the WebPurchasing home page, click Requisitions for Review. The Requisitions for 
Review page appears. This page lists the requisitions available for review.

2. Locate the requisition(s) you want to approve. To speed your search, you can use Search 
Requisitions for Review on the Activities tab. 
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3. Click the Review link next to the requisition you want to approve. The Review Requisition page 
appears.

4. Review the requisition order and make any changes to the information.

5. To approve all line items, click Approve All at the top of the Review Requisition page. The 
Status column in the line item grid changes to “Approved” for all line items.

6. To reject all requisition line items, click Reject All at the top of the page. The Status column in 
the line item grid changes to “Rejected” for all line items.

7. To approve an individual line item, in the line item grid, click Approve. The Status column 
changes to “Approved”.

8. To reject an individual line item, click Reject in the line item grid. The Status column changes to 
“Rejected”.

Note: If a requisition line item is rejected, you will need to create a new requisition for that item. 
Other approved line items in the requisition will continue through the approval process.

9. Click Finalize to finalize the approval. The requisition is sent to the next reviewer or to the 
business office if you are the final reviewer.

Create Receipts
Receipts are created for purchase orders. A receipt is a record created to keep a record of items or services 
your organization purchases and receives. In Accounts Payable, a receipt records whether purchase order 
line items are received, rejected or canceled.

Once an item on a purchase order is delivered to your organization, you can receipt the item. When you 
create a receipt for a purchase order, you automatically generate the entries required to reverse 
encumbrance transactions posted from a purchase order. You can create receipts in both WebPurchasing 
and The Financial Edge. With the receipting functionality in WebPurchasing, you can receive, reject, and 
cancel line items attached to a purchase order, and specify the quantity received and who will receive the 
items. Your user security settings determine whether you can create receipts for only yourself or for all 
users.
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Your organization should decide who can create receipts — a receiving department, specific user, or all 
users creating requisitions — and whether that user or users have rights to The Financial Edge. Creating 
receipts in WebPurchasing is helpful if you have multiple users that do not have access to The Financial 
Edge receipting functionality. If you only have a few users creating receipts, it may make more sense to 
give them rights to The Financial Edge and create receipts there.

Note: For more information about creating receipts in The Financial Edge, see the Records Guide for 
Accounts Payable.

 Create a receipt in WebPurchasing

Before you can create a receipt in WebPurchasing, you must generate a purchase order in
The Financial Edge. For more information about generating a purchase order, see “Generate Purchase
Orders” on page 61.

1. From the Home page in WebPurchasing, click the Find Purchase Order link under the Receive
list. The Purchase Orders page appears. This page lists purchase orders that have not been closed
or have not been printed.

Note: Your user security settings determine which purchase orders you see on this page. For 
example, you may be able to view purchase orders generated by everyone in your organization, or 
you may be able to view only purchase orders you generate. For more information about user 
security settings, see “User Security Setup” on page 5.

2. Locate the purchase order for which you want to create a receipt. You can use search options under
Search Purchase Orders on the left side of the page. The Receive link appears next to each
purchase order that has not been fully received.
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3. Click Receive to create a receipt. The Receive Purchase Order page appears. This page displays
line items for the selected purchase order.

4. Review the line items listed on your purchase order. 

5. To receive individual line items, in the line item grid, click Receive. The received items appear in
the Current Receipt box on the Activities tab. Clicking the minus button next to the item removes
it from the list and cancels the action.

6. To receive all line items for the purchase order, click Receive All at the top of the Purchase Order
Line Item page. The New Receipt page appears.

Note: To reject or cancel all line items within a purchase order, click Reject All or Cancel All at 
the top of the page. To reject a line item and replace it later, click Reject. To cancel a line item 
completely, click Cancel.
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7. In the Description field, enter a description of the items. For example, “May 2008 office supply 
order.”

8. The Receipt date field displays the current date. You may change the date in this field.

9. In the Received by field, select the individual who received the order. This is a required field.

10. In the Default Location field, select the area where the order was delivered.

11. In the Post Date field, enter the date for the line item to post. This is a required field.

12. In the Item Post Status field, “Not Yet Posted,” “Do Not Post,” or, “Wait For Invoice.” This is a 
required field.

13. If you need to create more receipts for this purchase order, click Add items to this receipt on the 
Activities tab. You return to the Purchase Order where you can select more items to add to the 
receipt.

14. To add a serial number to the line item, click Add SN under the Serial # column. The Serial 
Numbers screen appears.

15. In the Quantity of SN field, enter the number of serial numbers you want to add to the line item.

16. In the Serial Number field, enter the serial number.

17. To return to the Receipt page, click Save. The Serial # column displays the number of serial 
numbers you added to the line item.

18. To save the receipt and return to the Purchase Order page, click Save Receipt. 

Edit Receipts

Once you have created and finalized a receipt, you still have an opportunity to edit it until it is posted. For 
example, you may want to delete a line item, add a serial number to a line item within the receipt, or add 
more line items to the receipt.

 Edit a receipt

1. From the Home page in WebPurchasing, click the Find Purchase Order link under the Receive 
list. The Purchase Orders page appears. This page lists purchase orders that have not been printed 
or closed.
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2. To open a purchase order, click View. The Purchase Order Receipts page appears.

3. Under Receipts, click Edit to open the receipt you want to edit. The Receipt page appears.

Note: To delete the entire receipt, click Delete.

4. Make your changes to the receipt.

• You can change the information entered in the Description, Receipt date, Default Location, 
Received by, Item Post Date, and Item Post Status fields.

• Under Receipt Line Items, you can delete a line item or add a serial number to the line item.

• If you need to create more receipts for this purchase order, click Add items to this receipt on 
the Activities tab. You return to the Purchase Order where you can select more items to add to 
the receipt.
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• If you want to cancel the entire receipt, click Delete Receipt. This removes the line items from 
the purchase order and relieves the encumbrance accounts.

5. To save your changes and return to the Purchase Order Receipts page, click Save Receipt.

6. To return to the Purchase Orders page, click Back to PO List under the Activities tab.
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Business Office 
Processes

In this chapter

 “View Requisition Records” on page 56

 “Generate Purchase Orders” on page 61

 “View Purchase Orders” on page 67

 “View Receipts” on page 69

 “WebPurchasing Reports” on page 71

This chapter describes the business processes related to WebPurchasing that are performed in 
The Financial Edge. When requisitions are generated and approved in WebPurchasing, you can generate 
purchase orders automatically from those requisitions in The Financial Edge. In addition, you can view 
requisition and purchase order records, run reports, and create receipts. Users must have rights to 
The Financial Edge to use this functionality.
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View Requisition Records
Once you create requisitions in WebPurchasing, the requisition records appear in Accounts Payable and 
are accessed from the Records page. From Accounts Payable, click Records on the navigation bar and 
then click the Requisition link.

From this page, you can update requisitions and generate purchase orders. To quickly access requisitions, 
you can click a recently accessed record or use the Search for a Requisition by requisition ID field.

Open and Edit Requisition Records

To find and open a requisition, you need to be familiar with the Open screen. The Open screen has a 
number of filters you can use to narrow your search and quickly locate the requisition you want to open.

You access the Open screen by clicking Open a Requisition from the Requisitions page.

Note: For detailed information about the Open screen and each filter you can use, see the Program Basics 
Guide.
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 Open a requisition from the Requisition page of Records

1. From the Requisition page, click Open a Requisition. The Open screen for requisitions appears.

2. In the Find Requisitions that meet these criteria frame, enter the criteria you are using to search 
for the requisition. The criteria you can use includes a Requisition ID, Requester ID, Owner ID, 
Route to ID, Department, Status, Last modified by, and Last modified on.

3. After you enter your search criteria, click Find Now. The program searches your database and 
displays all requisitions that meet your search criteria. Again, depending on how limited or 
detailed your criteria are, the program may find one record or many records.

4. In the grid, select the requisition you want to open.

5. Click Open. The requisition appears.

6. Click Save and Close on the toolbar to return to the Requisitions page.
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 Edit a requisition line item

Once a requisition created in WebPurchasing is approved, you still have an opportunity to edit 
individual line items in The Financial Edge.

1. From the Requisitions page, open the requisition you want to edit.

2. To edit requisition line items, click the Line Items tab.
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3. Select the line item you want to edit and click Open on the action bar. The Requisition Line Item 
screen appears.

4. On the Line Item tab you can add or change information in the Vendor Name, Date required, 
External notes, Internal notes fields.

Note: Depending on your business rules, you can change the values in the Amount/quantity 
frame and reroute the requisition through the approval process. For more information about 
business rules, see “Configure Business Rules” on page 26.

5. Click the Purchase Order Information tab to add or edit any missing purchase order information 
to the selected line item.

a. In the Department field, select the department for which the order is being placed.

b. In the Ship via field, select the shipping method to use.

c. In the FOB (Freight on board) field, enter the point at which the client assumes ownership 
of the order.

d. In the Deliver to field, select the individual who will receive the order.

e. In the Ship to field, select the area to receive the order.

f. In the Buyer field, select the individual responsible for buying the item.



CH A P T E R 360 .
6. Click the Distribution tab to add or edit any GL Distribution information to the selected line item.

a. In the DR Account Number column, enter the debit accounts for the distribution. You can 
use the small binoculars to search for an account segment or use the large binoculars to search 
for an account number. When you enter a valid debit account number, the description appears 
automatically in the DR Account Description column.

You can also use a default account distribution defined in Configuration. Click Load 
Distribution and select From Table.

b. Enter the amount of the distribution in the Amount column. You can manually enter amounts 
for each account or you can click Distribute Evenly to distribute amounts equally among the 
selected accounts.

c. If you have the optional module Projects and Grants, enter a project ID number in the 
Project ID column, or use the binoculars to search for a project ID. When you enter a valid 
project ID number, the description appears automatically in the Project Description column.

d. In the Class column, select a class for the distribution.

e. If you have the optional module Projects and Grants and have defined transaction codes, 
additional columns appear based on the number of transaction codes you have defined. In the 
grid, select a value for each transaction code.

f. To enter different transaction distributions for the debit accounts in a distribution row, select 
the distribution row and click Distribution. The Debit Transaction Distribution screen 
appears.

You can also use this screen to split transaction distributions among multiple projects, 
classes, or transaction codes for a single debit account. When you have finished entering 
information, click OK to return to the requisition line item record Distribution tab.
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Note: On the Debit Transaction Distribution screen, you can click Load Distribution to select a 
transaction distribution defined in Configuration in Accounts Payable.

g. To attach transaction attributes to an account in the distribution, select the account and click 
Attributes on the action bar below the grid. When you have finished entering information, 
click OK to return to the requisition line item record Distribution tab.

7. Click the History of Changes tab to view the changes made to this requisition line item.

The grid displays Item Changed, Previous Setting, New Setting, Changed On, and Changed 
By columns. The History of Changes tab is for informational purposes only.

8. Click the Purchase Order Line Items tab to view the purchase order line items linked to the 
requisition line item.

Note: The information displayed in this tab appears only once a purchase order is generated.

9. To save changes made to the requisition line item, click Save and Close on the toolbar to return to 
the requisition record.

Generate Purchase Orders
Once a requisition created in WebPurchasing is approved, you can generate a purchase order from that 
requisition in The Financial Edge. You can create purchase orders on the Requisition page or the 
Purchase Orders page in Accounts Payable.
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 Generate a Purchase Order in Accounts Payable

1. From the Requisitions page, click Generate Purchase Orders from Requisitions. The Generate 
Purchase Orders from Requisitions screen appears.

2. Click Generate for and select to generate purchase orders for all records, selected records, or one 
record. If you choose Selected records, you must select a query of records. If you choose One 
record, you must select the record.

Note: Use this filter when you want to generate a purchase order for a specific requisition.

3. In the Post status/Date field, select “Not yet posted” or “Do not post.” If you select “Not yet 
posted,” you must enter a valid post date.

4. In the Interfund Set field, select an interfund set to create balancing entries if you enter debit and 
credit accounts from different funds. Interfund sets are defined in Configuration.

5. Mark Always use the unit price from the requisition line item or If a unit price exists on the 
product record, always use that price. This gives you the option to always use the price from the 
Product record in Configuration.
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6. Click Next to access the Grouping tab.

7. Mark Yes to group multiple requisitions into the same purchase order. When you mark Yes, you 
indicate how those requisitions should be combined on the PO Line Items tab (see step 9 of this 
procedure). For example, when Sally and Tom each create a requisition for the same vendor, one 
purchase order is generated.

If you do not want to group multiple requisitions into the same purchase order, mark No. Marking 
No, removes the PO Line Items tab and a separate purchase order is created for each requisition. 
For example, when Sally and Tom each create a requisition for the same vendor, two purchase 
orders are generated.
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8. Click Next to access the PO Line Items tab. This tab appears if you marked Yes on the Grouping 
tab.

9. Mark By Vendor only or By Vendor and purchase order information. If you choose By 
Vendor only, requisition line items are grouped by vendor. If you choose By Vendor and 
purchase order information, the requisition line items are grouped by vendor and the purchase 
order information you select. For example, Sally, Tom, and William each create a requisition for 
the same vendor. However, Sally and Tom are in the same department. If you choose to group 
requisition line items by vendor and department, two purchase orders are generated — one for 
William and one for Sally and Tom who are in the same department.

10. If you have two requisition line items for the same product, you need to determine how to handle 
them in the purchase order.

• To combine the two requisition line items into a single purchase order line item, mark Combine 
line items into a single PO line item.

• To keep the two requisition line items separate, mark Keep line items separate. For example, 
Sally and Tom each create a requisition for the same vendor to order a computer. You choose to 
group requisitions by vendor only to generate one purchase order. However, when you mark 
Keep line items separate, two separate line items are created for each computer when the 
purchase order is generated.
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11. Click Next to access the PO Information tab. Use this tab to add any missing information for all 
purchase orders generated.

• If no grouping settings were defined for requisition line items on the Grouping tab, the purchase 
order information selected on the PO Information tab overwrites the purchase order information 
on an individual requisition line item. For example, if you group two requisition line items By 
Vendor and By Department and both line items have purchase order information defined, the 
purchase order information defined on the PO Information tab overwrites what is on each 
individual line item.

• If two requisition line items are grouped and they both have purchase order information defined, 
the purchase order information of the first line item overwrites the purchase order information 
of the second line item.

12. In the Ship via field, select the shipping method to use.

13. In the FOB (Freight on board) field, enter the point at which the client assumes ownership of the 
order.

14. In the Terms field, select how you want to pay a vendor. Terms are payment rules established for 
payments to vendors or payments from customers. Terms specify how long a customer who 
purchases on account may wait to pay an invoice. Terms may include discount provisions for early 
payment of an invoice.

15. In the Buyer field, select the individual responsible for buying the items.

16. In the Ship to field, select the area to receive the order.

17. In the Department field, select the department for which the order is being placed.

18. In the Confirm to field, enter the name of the person with whom the order was placed.

19. In the Attention field, enter the name of the person to whom the package is being shipped.

20. In the Comments field, enter any comments to associate with this purchase order. These 
comments are printed on the bottom of the purchase order.
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21. Click Next to access the Results tab.

22. If there is not a vendor on the requisition line item, enter the vendor name in the Vendor column 
or click the binoculars to locate the vendor.

23. If the checkbox is marked in the Has Suggested Vendor column, double-click the line item to 
view the suggested vendor information. You can decide to add the new vendor to Accounts 
Payable.
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Tip: If this column does not appear in the grid, right-click and select Columns. From the Columns 
screen, mark the checkbox next to Has Suggested Vendor.

24. In the Quantity to Order column, enter the number of line items you want to order.

25. In the Date Promised field, enter the date the vendor promised to deliver the item.

26. Click Create All to fill the Quantity to Order column with the remaining amount to order.

27. Click Pre-Generation Report to view the Control Report. If you do not like the results displayed 
in the Control Report, close the report and click Back to change the settings on the previous tabs.

28. Click Generate Now to generate purchase orders.

Miscellaneous Line Items in WebPurchasing

You can now use miscellaneous line items in WebPurchasing when creating purchase orders by requesting 
a one-time product at a flat amount. For example, let’s say you have contract for a dollar amount of 
services rendered, such as security consulting for $1 million for the year. The security firm charges a flat 
amount for each event they work, and your organization receipts this amount each time it uses the service.

Here is the suggested the workflow:

• Use WebPurchasing to request a one-time product with a flat amount value. You can do this from the 
Purchasing tab on the Request One-time Product page. Select the vendor, then enter a product 
description, price, and any additional notes you might need. Next, add this flat amount item to your cart.

• Once the requisition is added to your cart, review the information and select Create Requisition. Now 
you can submit the requisition, which goes to the person at your organization who typically reviews 
them.

• Once the requisition is approved, it is sent to the Generate Purchase Orders from Requisitions wizard 
in The Financial Edge. To access this wizard, go to Accounts Payable, Records, Requisitions. 

• You can create the Purchase Order here by selecting Generate Now.

• You can then receipt the Purchase Order through The Financial Edge or WebPurchasing. You can also 
receive a dollar amount as opposed to a quantity.

Note: We recommend you enable two Requisition business rules in Accounts Payable: Allow users to 
change the unit price (or total price for flat amount items) for items in their Shopping Cart, and 
Allow approvers to edit the unit price and quantity (or total price for flat amount items) on 
Requisition line items.

View Purchase Orders
The Purchase Orders page is the starting point for purchase order records. To access this page, in Accounts 
Payable, click Records on the navigation bar and then click the Purchase Orders link.
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Note: The Purchase Orders link appears on the Records page only if you have installed the optional 
module Purchase Orders.

From the Purchase Orders page, you can add a new purchase order record, open existing records, and close 
purchase orders. You can also edit purchase order options by clicking Edit options for Purchase Orders. 
This link opens the Options screen for records.

To save time when searching for a specific purchase order record, you can use the Search for a Purchase 
Order by purchase order number field. The Purchase Orders page also lists recently accessed purchase 
order records.

 Open a purchase order record

1. On the navigation bar, click Records.

2. Click Purchase Orders. The Purchase Orders page appears.

3. Click Open a Purchase Order. The Open screen for purchase orders appears.
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4. In the Find Purchase Orders that meet these criteria frame, enter the criteria you are using to 
search for the purchase order. Criteria you can use include a vendor name, ID, phone number, city, 
or state.

5. After you enter search criteria, click Find Now. The program searches the database and displays 
all purchase orders that meet your search criteria.

6. In the grid, select the purchase order to open.

7. Click Open. The purchase order record appears.

8. After you view or edit the record, click Save and Close on the toolbar.

View Receipts
To find and open a receipt, you need to be familiar with the Open screen. The Open screen has a number of 
filters you can use to narrow your search and quickly locate the receipt you want to open. You access the 
Open screen by clicking Open a Receipt from the Receipts page.
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Note: For detailed information about the Open screen and each filter you can use, see the Program Basics 
Guide.

 Open a receipt

1. On the navigation bar, click Records.

2. Click Receipts. The Receipts page appears.

3. Click Open a Receipt. The Open screen for receipts appears.

4. In the Find Receipts that meet these criteria frame, enter the criteria you are using to search for 
the receipt. Criteria you can use include a vendor name, ID, phone number, city, or state.

5. After you enter your search criteria, click Find Now. The program searches your database and 
displays all receipts that meet your search criteria. Again, depending on how limited or detailed 
your criteria are, the program may find one record or many records.

6. In the grid, select the receipt to open.

7. Click Open. The receipt appears.
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8. After you view or edit the record, click Save and Close on the toolbar.

WebPurchasing Reports
There are several reports in Accounts Payable that you can run to monitor, evaluate, and distribute 
information about the requisitions, purchase orders, and receipts created in WebPurchasing.

 Select a report

1. From the navigation bar in Accounts Payable, click Reports. The Reports page appears.

2. Click Purchase Order Reports. The Purchase Order Reports page appears.

3. Select a report from the list. The reports that you can generate for your WebPurchasing tasks 
include:

• “Requisition Detail Report” on page 71

• “Requisition Profile Report” on page 81

• “Requisition List Report” on page 92

• “Purchase Order Detail Report” on page 101

• “Receipt Report” on page 113

Requisition Detail Report

The Requisition Detail Report lists subordinate line item detail for specified requisitions and periods of 
time. All totals are presented in terms of transaction totals and do not include outstanding balances.
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The Requisition Detail Report has three tabs on which you set parameters: General tab, Filters tab, and 
Format tab. To move among the tabs in a report, use Next and Back at the bottom of the screen or select 
the tab itself. On these tabs you specify the records to include in the report and how the report should look. 
For more information about creating a report, see the Reports Guide for Accounts Payable.

• “Requisition Detail Report General Tab” on page 72

• “Requisition Detail Report Filters Tab” on page 73

• “Requisition Detail Report Format Tab” on page 74

Requisition Detail Report General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the 
information included in the report.

• Submitted on – Specify a date for requisitions to include. If you select a <Specific Range>, you can 
specify a start and end date. If the Start date field is blank, all activity is included up to the end date. If 
the End date field is blank, all activity from the start date forward is included. If both fields are blank, 
all activity is included.

• Include line items with a total amount between [ ] and [ ] – To include only line items with a certain 
total amount, mark this checkbox.

If the first field is blank, all amounts up to the amount in the second field are included. If the second field 
is blank, all amounts greater than the amount in the first field are included. If both fields are blank, all 
amounts are included.

• Show purchase order line item detail – Mark this checkbox to show the purchase order line items.

• Create an output query of requisitions – If you mark this checkbox, the program creates a query of 
requisitions included in the report. You can use the query later in other areas of Accounts Payable.



WE BPU R C H A S I N G BU S I N E S S OFFI C E PR O C E SS E S 73.
• Report orientation – Select Portrait for the report to appear vertically or Landscape for the report to 
appear horizontally.

Requisition Detail Report Filters Tab

On the Filters tab, you can include information based on selected criteria including: Requisitions, Vendors, 
Departments, and Products. For example, you can include requisitions within a selected range and 
requisitions not falling within the range are excluded from the report. For more information about filtering 
in The Financial Edge, see the Program Basics Guide.

• Open – Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on 
which you specify filters.

• Clear All Filters – Click Clear All Filters to remove all previously selected filters from the report.

• Filters – The Filters column lists all the available filters for this report. You cannot edit this column.

Note: A filter controls what records are included in a report. For example, if you apply the Account filter, 
only the accounts you select are included in the report.

• Include – In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to 
designate specific filters.

• Selected Filters – Filters you specify appear in the Selected Filters column. If you choose Selected in 
the Include column or click a filter and click Open on the action bar, the Selected <Filter> screen 
appears. Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously 
created query of filters. Depending on your selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.
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Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define 
filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

• Previous Filter – To view or edit the previous filter without returning to the Filters tab, click 
Previous Filter.

• Next Filter – To view or edit the next filter without returning to the Filters tab, click Next Filter.

Requisition Detail Report Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option 
is provided.

• Headings – Use Headings to enter the name of your report. You can enter a maximum of 60 characters 
in each of the Title and Subtitle fields. A default title appears in the Title field that you can change. The 
title and subtitle appear at the top of the report. You can select the heading alignment and whether your 
organization's name appears in the header.
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You can include other options in the header, such as the page number and the date. Mark Print report 
headings on each page to include the header on every page of the report.
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• Criteria – Use Criteria to help you remember the criteria you used to create the report. Mark Print 
these criteria on and select a separate page or the first page. Mark the checkboxes for the criteria you 
want to show.

• Sort/Break – Use Sort/Break to select the order information appears on the report. When you select 
Sort/Break on the Format tab, a grid displays the categories you can sort in the report. Select a sorting 
category in the Sort by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by the requisition number 
in ascending order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text 
after value fields, you can enter up to 30 characters in each field for information you want to print 
directly before and after the break. If you mark Print count per Requisition Number or Print count as 
percentage of total for the selected sort field, the number or percentage for each selected sort option 
appears in the footer. If you mark Page break on each new Requisition Number, a new page starts for 
the highest level break.
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• Page Footer – Use Page Footer to create a footer to appear at the bottom of each page of the report. 
You can enter a maximum of 254 characters in the Text field to print as the page footer. You can select 
the alignment of the footer and whether to include other options, such as the page number and date.
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• Report Footer – Use Report Footer to create a footer to appear at the bottom of the last page of the 
report. You can enter a maximum of 254 characters in the Text field to show as the report footer. In the 
Align field, select the alignment of the footer.
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• Miscellaneous – Use Miscellaneous to specify the font size and how numbers appear on the report.
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• Color Scheme – Use Color Scheme to select colors for report headings. When you click the color box 
next to the selection, the Color screen appears so you can select a standard color or define a custom 
color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

Requisition Profile Report

The Requisition Profile Report presents biographical and summary information for specified requisitions 
and subordinate line item detail for a specified period of time. You can select to include distribution 
information for each requisition line item in the report.

The Requisition Profile Report has three tabs on which you set parameters: General tab, Filters tab, and 
Format tab. To move among the tabs in a report, use Next and Back at the bottom of the screen or select 
the tab itself. On these tabs you specify the records to include in the report and how the report should look. 
For more information about creating a report, see the Reports Guide for Accounts Payable.

• “Requisition Profile Report General Tab” on page 82

• “Requisition Profile Report Filters Tab” on page 83

• “Requisition Profile Report Format Tab” on page 84
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Requisition Profile Report General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the 
information included in the report.

• Include these report sections – You select the sections to appear on the report. Each requisition will 
appear with a section that lists information from the General tab of the requisition record. Mark Line 
Item Detail, Attributes, and History of changes to include these sections. If a section does not exist for 
a requisition, it does not show on the report even if the item is marked. For example, if a requisition does 
not have an attribute, the Attributes section does not appear for that requisition.

• Submitted on – In the Submitted on field, specify a date for requisitions to include.

• Date needed – In the Date Needed field, specify a date for requisitions to include. This date pulls from 
the Needed by field on a requisition record. 

If you select a <Specific Range>, you can specify a start and end date. If the Start date field is blank, all 
activity is included up to the end date. If the End date field is blank, all activity from the start date 
forward, including requisitions with a needed date in the future, is included. If both fields are blank, all 
activity is included.

• Include requisitions with a total between [ ] and [ ] – To only include line items with a certain total 
amount, mark Include line items with a total amount between.

If the first field is blank, all amounts are included up to the amount in the second field. If the second field 
is blank, all amounts greater than the amount in the first field are included. If both fields are blank, all 
amounts are included.

• Create an output query requisitions – If you mark Create an output query of requisitions, the 
program creates a query of requisitions included in the report. You can use the query later in other areas 
of Accounts Payable.

• Report Orientation – This report defaults to Landscape.
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Requisition Profile Report Filters Tab

On the Filters tab, you can include information based on selected criteria including: Requisitions, 
Departments, and Requisition Attributes. For example, you can include requisitions within a selected range 
and requisitions not falling within the range are excluded from the report. For more information about 
filtering in The Financial Edge, see the Program Basics Guide.

• Open – Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on 
which you specify filters.

• Clear All Filters – Click Clear All Filters to remove all previously selected filters from the report.

• Filters – The Filters column lists all the available filters for this report. You cannot edit this column.

Note: A filter controls what records are included in a report. For example, if you apply the Account filter, 
only the accounts you select are included in the report.

• Include – In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to 
designate specific filters.

• Selected Filters – Filters you specify appear in the Selected Filters column. If you choose Selected in 
the Include column or click a filter and click Open on the action bar, the Selected <Filter> screen 
appears. Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously 
created query of filters. Depending on your selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.
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Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define 
filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

• Previous Filter – To view or edit the previous filter without returning to the Filters tab, click 
Previous Filter.

• Next Filter – To view or edit the next filter without returning to the Filters tab, click Next Filter.

Requisition Profile Report Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option 
is provided.

• Headings – Use Headings to enter the name of your report. You can enter a maximum of 60 characters 
in each of the Title and Subtitle fields. A default title appears in the Title field that you can change. The 
title and subtitle appear at the top of the report. You can select the heading alignment and whether your 
organization's name appears in the header.
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You can include other options in the header, such as the page number and the date. Mark Print report 
headings on each page to include the header on every page of the report.
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• Criteria – Use Criteria to help you remember the criteria you used to create the report. Mark Print 
these criteria on and select a separate page or the first page. Your selections print in the criteria section 
of the report. 

• Detail – Use Detail to select the amount of information that appears for requisitions and the subordinate 
line items. Mark Show history of changes for line items to show the changes made to line items on a 
requisition. Mark Show notes for line items to show the note from the requisition line item.
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To see the distribution of a line item, mark Show distribution for these characteristics and choose the 
characteristics to appear. This will create an additional line on the report for the characteristics with the 
corresponding debit and credit amount.

• Sort – Use Sort to select the order information appears on the report. When you select Sort on the 
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort 
by column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by the requisition number 
in ascending order. If you mark Page break on each new Requisition Number, a new page starts for 
the highest level break.
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• Page Footer – Use Page Footer to create a footer to appear at the bottom of each page of the report. 
You can enter a maximum of 254 characters in the Text field to print as the page footer. You can select 
the alignment of the footer and whether to include other options, such as the page number and date.
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• Report Footer – Use Report Footer to create a footer to appear at the bottom of the last page of the 
report. You can enter a maximum of 254 characters in the Text field to show as the report footer. In the 
Align field, select the alignment of the footer.
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• Miscellaneous – Use Miscellaneous to specify the font size and how the numbers to appear on the 
report.
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• Color Scheme – Use Color Scheme to select colors for report headings. When you click the color box 
next to the selection, the Color screen appears so you can select a standard color or define a custom 
color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

Requisition List Report

The Requisition List presents a list of all requisitions for a specified date range. The Requisition List has 
three tabs on which you set parameters: General tab, Filters tab, and Format tab. To move among the tabs 
in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you specify 
the records to include in the report and how the report should look. For more information about creating a 
report, see the Reports Guide for Accounts Payable.

• “Requisition List Report General Tab” on page 93

• “Requisition List Report Filters Tab” on page 94

• “Requisition List Report Format Tab” on page 95
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Requisition List Report General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the 
information included in the report.

• Submitted on – Specify a date for requisitions to include. If you select a <Specific Range>, you can 
specify a start and end date. If the Start date field is blank, all activity is included up to the end date. If 
the End date field is blank, all activity from the start date forward is included. If both fields are blank, 
all activity is included.

• Include line items with a total amount between [ ] and [ ] – To only include line items with a certain 
total amount, mark this checkbox.

If the first field is blank, all amounts are included up to the amount in the second field. If the second field 
is blank, all amounts greater than the amount in the first field are included. If both fields are blank, all 
amounts are included.

• Create an output query of requisitions – If you mark this checkbox, the program creates a query of 
requisitions included in the report. You can use the query later in other areas of Accounts Payable.

• Report orientation – Select Portrait for the report to appear vertically or Landscape for the report to 
appear horizontally.
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Requisition List Report Filters Tab

On the Filters tab, you can include information based on selected criteria including: Requisitions, 
Departments, and Requisition Attributes. For example, you can include requisitions within a selected range 
and requisitions not falling within the range are excluded from the report. For more information about 
filtering in The Financial Edge, see the Program Basics Guide.

• Open – Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on 
which you specify filters.

• Clear All Filters – Click Clear All Filters to remove all previously selected filters from the report.

• Filters – The Filters column lists all the available filters for this report. You cannot edit this column.

Note: A filter controls what records are included in a report. For example, if you apply the Account filter, 
only the accounts you select are included in the report.

• Include – In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to 
designate specific filters.

• Selected Filters – Filters you specify appear in the Selected Filters column. If you choose Selected in 
the Include column or click a filter and click Open on the action bar, the Selected <Filter> screen 
appears. Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously 
created query of filters. Depending on your selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.
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Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define 
filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

• Previous Filter – To view or edit the previous filter without returning to the Filters tab, click 
Previous Filter.

• Next Filter – To view or edit the next filter without returning to the Filters tab, click Next Filter.

Requisition List Report Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option 
is provided.

• Headings – Use Headings to enter the name of your report. You can enter a maximum of 60 characters 
in each of the Title and Subtitle fields. A default title appears in the Title field that you can change. The 
title and subtitle appear at the top of the report. You can select how you want the heading aligned and 
whether you want your organization’s name to appear in the header.
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You can include other options in the header, such as the page number and the date. You can also select to 
include the header on every page of the report.



WE BPU R C H A S I N G BU S I N E S S OFFI C E PR O C E SS E S 97.
• Criteria – Use Criteria to help you remember the criteria you used to create the report. Mark Print 
these criteria on and select a separate page or the first page. Your selections print in the criteria section 
of the report.

• Sort/Break – Use Sort/Break to select the order information appears on the report. When you select 
Sort/Break on the Format tab, a grid displays the categories you can sort in the report. Select a sorting 
category in the Sort by column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by the requisition number 
in ascending order. If you mark Page break on each new Requisition Number, a new page starts for 
the highest level break.
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• Page Footer – Use Page Footer to create a footer to appear at the bottom of each page of the report. 
You can enter a maximum of 254 characters in the Text field to print as the page footer. You can select 
the alignment of the footer and whether to include other options, such as the page number and date. 
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• Report Footer – Use Report Footer to enter a maximum of 254 characters in the Text field and select 
the footer alignment. The report footer appears at the end of the report.

• Miscellaneous – Use Miscellaneous to specify the font size and how numbers appear on the report.
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• Color Scheme – Use Color Scheme to select colors for report headings. When you click the color box 
next to the selection, the Color screen appears so you can select a standard color or define a custom 
color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

Purchase Order Detail Report

The Purchase Order Detail Report presents regular and blanket purchase order detail and subordinate line 
item detail for a specified period of time. You can select to include all distribution information for each 
purchase order line item in the report and show the linked requisition. All totals are presented in terms of 
transaction totals and do not include outstanding balances. The option to include a summary for each 
combination of transactional characteristics at the end of the report is available.

The Purchase Order Detail Report has three tabs on which you set parameters: General tab, Filters tab, and 
Format tab. To move among the tabs in a report, use Next and Back at the bottom of the screen or select 
the tab itself. On these tabs you specify the records to include in the report and how the report should look. 
For more information about creating a report, see the Reports Guide for Accounts Payable.

• “Purchase Order Detail Report General Tab” on page 102

• “Purchase Order Detail Report Filters Tab” on page 103

• “Purchase Order Detail Report Format Tab” on page 104
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Purchase Order Detail Report General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the 
information included in the report.

• Purchase order date – In the Purchase Order date field, select a date range for purchase orders to 
include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all 
activity is included up to the end date. If the End date field is blank, all activity from the start date until 
present is included. If both fields are blank, all activity is included.

• Date promised – In the Date promised field, select a promised date or date range to include in the 
report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all 
activity is included up to the end date. If the End date field is blank, all activity from the start date until 
present is included. If both fields are blank, all activity is included.

• Date required – In the Date required field, select a required date or date range to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all 
activity is included up to the end date. If the End date field is blank, all activity from the start date until 
present is included. If both fields are blank, all activity is included.

• Show – In the Show field, select All line items or Only line items with these dates. If you select All line 
items, the report includes all line items on purchase orders that meet the date requirements. If you select 
Only line items with these dates, the report includes only line items that meet the date requirements.

• Show linked requisition line items – Mark this checkbox to show requisition line items that are 
associated with each purchase order.

• Create an output query of – If you mark this option, the system creates a query of the record you select 
and includes it in the report. This query is available for use in other areas of the program.
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• Report orientation – Landscape is the only report orientation available for this report.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to 
view a sample layout of the report without data.

Purchase Order Detail Report Filters Tab

On the Filters tab, you can include information based on selected criteria including: Vendors, Purchase 
Orders, Purchase Order Attributes, Purchase Order Statuses, Purchase Order Types, Departments, and 
Buyers. For example, you can include purchase orders within a selected range and purchase orders not 
falling within the range are excluded from the report. For more information about filtering in 
The Financial Edge, see the Program Basics Guide.

• Open – Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on 
which you specify filters.

• Clear All Filters – Click Clear All Filters to remove all previously selected filters from the report.

• Filters – The Filters column lists all the available filters for this report. You cannot edit this column.

Note: A filter controls what records are included in a report. For example, if you apply the Account filter, 
only the accounts you select are included in the report.

• Include – In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to 
designate specific filters.
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• Selected Filters – Filters you specify appear in the Selected Filters column. If you choose Selected in 
the Include column or click a filter and click Open on the action bar, the Selected <Filter> screen 
appears. Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously 
created query of filters. Depending on your selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.

Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define 
filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

• Previous Filter – To view or edit the previous filter without returning to the Filters tab, click 
Previous Filter.

• Next Filter – To view or edit the next filter without returning to the Filters tab, click Next Filter.

Purchase Order Detail Report Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option 
is provided.

• Headings – Use Headings to enter the name of your report. You can enter a maximum of 60 characters 
in each of the Title and Subtitle fields. A default title appears in the Title field that you can change. The 
title and subtitle appear at the top of the report. You can select how you want the heading aligned and 
whether you want your organization’s name to appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to 
include the header on every page of the report.
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Note: The heading defaults to Purchase Order Detail Report in the Title field. You can leave this as the title 
for the report or enter your own.

• Criteria – Select Criteria to print a list of criteria used to create the report. Mark Print these criteria 
on and select a separate page or the first page. All selected options print in the criteria section of the 
report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print 
with the report.
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• Detail – Use Detail to select details specific to the Purchase Order Detail Report. Mark the checkboxes 
to show distribution by transaction characteristics. If you have the optional module Projects and Grants 
and have defined transaction codes, additional checkboxes appear.



CH A P T E R 3108.
• Grand Totals – Use Grand Totals to show combined totals for transaction characteristics. If you have 
the optional module Projects and Grants and have defined transaction codes, additional checkboxes 
appear.

• Sort/Break – Use Sort/Break to select the order information appears on the report. When you select 
Sort/Break on the Format tab, a grid displays the categories you can sort in the report. Select a sorting 
category in the Sort by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by the entire purchase 
order number in ascending order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text 
after value fields, you can enter up to 30 characters in each field for information you want to print 
directly before and after the break. If you mark Print count per Purchase Order Number or Print 
count as percentage of total for the selected sort field, the number or percentage for each selected sort 
option appears in the footer. If you mark Page break on each new Purchase Order Number, a new 
page starts for the highest level break.
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• Page Footer – You can enter a maximum of 254 characters in the page footer. You can also include 
other options, such as the page number and date. 
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• Report Footer – You can enter a maximum of 254 characters in the report footer and select how you 
want text aligned. The report footer appears at the end of the report.
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• Miscellaneous – Use Miscellaneous to specify how you want numbers to appear on the report and the 
font size for the report.
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• Color Scheme – You can apply a color scheme to the column heading and group heading of the report. 
When you click in the color box next to the selection, a Color screen appears from which you can select 
a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the report 
prints in black.

Receipt Report

The Receipt Report presents extended cost information versus actual cost information for line items 
received. This is an activity-based report and compares the line item extended cost to the receipt amount 
for each line item receipted in Accounts Payable. This report also shows the requisition delivery 
information.

The Receipt Report has three tabs on which you set parameters: General tab, Filters tab, and Format tab. 
To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. 
On these tabs you specify the records to include in the report and how the report should look. For more 
information about creating a report, see the Reports Guide for Accounts Payable.

• “Receipt Report General Tab” on page 114

• “Receipt Report Filters Tab” on page 115

• “Receipt Report Format Tab” on page 116
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Receipt Report General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the 
information included in the report.

• Report format – In the Report format field, select Detail or Summary as the report format.

• Receipt date – In the Receipt date field, select a date range for receipts to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all 
activity is included up to the end date. If the End date field is blank, all activity from the start date until 
present is included. If both fields are blank, all activity is included.

• Include only receipts that have no associated invoices – Mark this checkbox to include only receipts 
with no associated invoices.

• Print serial numbers – Mark this checkbox to print serial numbers on the report.

• Show receipt line item information – Mark this checkbox to include only receipts with no associated 
invoices.

• Show requisition deliver to information sorted by [ ] ordered by [ ] – Mark this checkbox to show 
delivery information. You can sort by Date Needed, Submitted On, or Deliver To. You can then order the 
requisitions in ascending or descending order.

• Create an output query of – If you mark this option, the system creates a query of the record you select 
and includes it in the report. This query is available for use in other areas of the program.

• Report orientation – Landscape is the only report orientation available for this report.
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Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to 
view a sample layout of the report without data.

Receipt Report Filters Tab

On the Filters tab, you can include information based on selected criteria including: Vendors, Receipts, 
Purchase Orders, Invoices, and Receipt Types. For example, you can include purchase orders within a 
selected range and purchase orders not falling within the range are excluded from the report. For more 
information about filtering in The Financial Edge, see the Program Basics Guide.

• Open – Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on 
which you specify filters.

• Clear All Filters – Click Clear All Filters to remove all previously selected filters from the report.

• Filters – The Filters column lists all the available filters for this report. You cannot edit this column.

Note: A filter controls what records are included in a report. For example, if you apply the Account filter, 
only the accounts you select are included in the report.

• Selected Filters – Filters you specify appear in the Selected Filters column. If you choose Selected in 
the Include column or click a filter and click Open on the action bar, the Selected <Filter> screen 
appears. Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously 
created query of filters. Depending on your selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.



CH A P T E R 3116.
Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define 
filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

• Previous Filter – To view or edit the previous filter without returning to the Filters tab, click Previous 
Filter.

• Next Filter – To view or edit the next filter without returning to the Filters tab, click Next Filter.

Receipt Report Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option 
is provided.

• Headings – Use Headings to enter the name of your report. You can enter a maximum of 60 characters 
in each of the Title and Subtitle fields. A default title appears in the Title field that you can change. The 
title and subtitle appear at the top of the report. You can select how you want the heading aligned and 
whether you want your organization's name to appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to 
include the header on every page of the report.
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Note: The heading defaults to Receipt Report in the Title field. You can leave this as the title for the report 
or enter your own.

• Criteria – Select Criteria to print a list of criteria used to create the report. Mark Print these criteria 
on and select a separate page or the first page. All selected options print in the criteria section of the 
report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print 
with the report.

• Sort/Break – Use Sort/Break to select the order information appears on the report. When you select 
Sort/Break on the Format tab, a grid displays the categories you can sort in the report. Select a sorting 
category in the Sort by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by the entire receipt 
number in ascending order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text 
after value fields, you can enter up to 30 characters in each field for information you want to print 
directly before and after the break. If you mark Print count per Receipt Number or Print count as 
percentage of total for the selected sort field, the number or percentage for each selected sort option 
appears in the footer. If you mark Page break on each new Receipt Number, a new page starts for the 
highest level break.
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• Page Footer – You can enter a maximum of 254 characters in the page footer. You can also include 
other options, such as the page number and date.
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• Report Footer – You can enter a maximum of 254 characters in the report footer and select how you 
want text aligned. The report footer appears at the end of the report.
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• Miscellaneous – Use Miscellaneous to specify how you want numbers to appear on the report and the 
font size for the report.
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• Color Scheme – You can apply a color scheme to the column heading and group heading of the report. 
When you click in the color box next to the selection, a Color screen appears from which you can select 
a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the report 
prints in black.
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4CHAPTER
Administration Tasks

In this chapter

 “Manage Active Users” on page 125

 “Manage the Email Queue” on page 126

If you have supervisor rights and access The Financial Edge WebPortal, you can perform several 
administrative tasks through the Administration page. On the Administration page, you can view active 
users, log users out of WebInvoicing and WebPurchasing, and manage your email queue.

Manage Active Users
On the Active Users page, you can see who in your organization is using WebPortal. In addition, you can 
log out users from WebPortal on this page.

 Manage active users

1. From the WebPortal Home page, click View Active Users. The Active Users page appears. This 
page lists all the users in your organization currently using WebPortal. 
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Note: In the Activities tab, you can search for a specific user by name, or IP address. In addition, 
you can sort the list of users by “Last Activity”, “Last Activity (Descending)”, “User Name”, or 
“IP Address”.

2. To log a user out of WebPortal, click the Remove User button, next to the user name. A message 
appears to confirm the action. Click Yes and the user is logged out of WebPortal.

3. To log all users out of WebPortal, click Disconnect All Users under the Activities tab. A message 
appears to confirm the action. Click Yes and all users are logged out of WebPortal.

Manage the Email Queue
The Email Queue page lists all the email messages generated by users in your organization. Through the 
Email Queue you can see what email messages have been sent or waiting to be sent. You can resend email 
messages or delete them. Each message listed on the Email Queue is assigned a status:

• “Sent” – The email was sent.

• “Pending” – The email has not been sent.

• “Cancelled” – The WebPortal email service cancelled the email.

• “Errored” – There was a problem linking to the email server.
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 Resend email messages

You can resend email messages with a “Cancelled” or “Errored” status.

1. From the WebPortal Home page, click View Email Queue. The Email Queue page appears.

Note: Sent email messages do not appear on this page. To show all sent email messages, click 
Show sent Emails under the Activites tab.

2. To resend a specific email, select it from the grid and click the Send button.

3. To resend all email messages, click Send All Emails under the Activities tab. A message appears 
asking you to confirm the action. Click Yes. This changes all “Cancelled” and “Errored” email 
messages to “Pending”. The “Pending” email messages are sent during time intervals defined on 
the Configuration Tool. For more information about the Configuration Tool, see The Installation 
Guide for WebPortal.

 Delete email messages

If you have email messages listed in the queue that are no longer valid, you can delete them.

1. From the WebPortal Home page, click View Email Queue. The Email Queue page appears.

2. To delete a specific email, select it from the grid and click Delete.

3. To delete all email messages, click Delete All Emails. A message appears asking you to confirm 
the action. Click Yes. This deletes all “Sent”, “Pending”, “Cancelled”, and “Errored” email 
messages.
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